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New in Revision D of the Release Notes

This Revision D of the OnePoint Messenger 2.0 Release Notes is for Service Pack 1. The
following summary lists the changes in the Notes from the previous revision:

• The "Installation_Notes" section contains these changes:

• Use NuPoint Messenger RSD 2 when integrating OnePoint Messenger with NuPoint
Messenger.

• Set startup mode to Manual when running SmartUpdate.

• The "New Features" section contains a note about the two new prompt languages introduced in
Service Pack 1 and about two new utilities—Cvviewmsg.exe and Tracebak.cfg.

• The following table summarizes the problems fixed this Service Pack 1 that had been in the list
of Known Issues in the previous version of the Release Notes. For details, see the section
"Previously Listed Known Issues Fixed in Service Pack 1".

Problem Number Short Description

4000-113653;
4000-113996

Language Defaults

4000-113769 AG Config, Benign Error Message

4000-113812 Isolated AG-0 Ports Answer with Dead Air

4000-113847 RPC Error-User Profile Editing Error Message

4000-113874 Text-to-Speech Dictionary Not Editable

4000-113977 MWI Restart when Exchange Rebooted

4000-113992 SX-2000: System Recovery after Loss of MiTAI Link

4000-113923 TUI: TTS Announces Name of Reply Recipient (CR)

4000-113995 FAX: Telephony Server Does Not Answer after Receiving Fax

4000-114009 SDR: # and * Keys Do Not Work with "Allow cut through
extensions"

4000-114010 SDR: Eight-second Delay during Transfer
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• The following table summarizes the problems fixed this Service Pack 1 that were not in the list
of Known Issues in the Release Notes for the base release. For details, see the section
"Previously Unlisted Issues":

Problem Number Short Description

4000-113169,
4000-113656

Timeout Value Setting for Caller Response

4000-113726 Business Hours Did Not Control Greeting Correctly

4000-113859 Logging into Mailbox That Has No Extension

4000-113889 Attendant Mailbox Available from the Automated Attendant

4000-113905 PIN (Prefix String) For a Pager

4000-113907 Correction to Installation of SNT SR 2 Baypt24NMS Patch

4000-113908 Correction to Installation of DAO

4000-113984 Timestamp on VPIM Messages

4000-113994,
4000-113991

Directory Initialization Program Warning to Stop Services

4000-114028 TMP Files Cleaned from Telephony Server

4000-114041 Faxes Delivered in Walkaway Fax or DID Fax Call

4000-114042 SDR Option "Deliver Fax to Caller" Prompts

4000-114052,
4000-114075

Port Does Not Answer

4000-114070 Callback Number Prompts

4000-114111 Attendant Extension Highlighted when Disabled

4000-114114 Group Configuration Node of TS Admin, Plus Sign

4000-114136 Fax Tone Generated for Fax Sent by Desktop Client

• The "Known Issues" section contains several new previously unlisted issues:

• The Telephony Server directory is erased by the 2 A.M. directory synchronization if the
Exchange Server is unavailable. (CR 4000-114023)

• Brooktrout Fax Configuration Wizard, Inconsistent Operation (CR 4000-114019)

• Directory Synchronization Fails if Exchange Server Is Down (CR 4000-114023)

• Directory Synchronization Fails for Mailbox Starting with Digit (CR 4000-114161)

• Installation Delay (CR 4000-114268)

• Message Delivery Page Prompts May Be Incorrect (CR 4000-113926)

• In the "Limitations of the Software" section, a note labeled "Fax Document Subject" says that
fax documents created by the Unified Fax Printer are limited to 45 characters in their Subject
lines.
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• The section "Product and Configuration Notes" contains a note on the upgraded Brooktrout
Fax Configuration Wizard installed by OnePoint Messenger 2.0 Service Pack 1. The wizard
now enables you to select A-Law encoding for the fax card.

New in Revision C of the Release Notes

The following changes are noted in Revision C of the OnePoint Messenger 2.0 Release Notes:

• The "Installation Notes" section contains augmented instructions for upgrading from OnePoint
Messenger 1.1.

• The section "Turnkey Telephony Server Installation Notes" notes the TS800 administrator
name and password installed at the factory.

• The "New Features" and "Documentation" sections list added support for Cisco CallManager
and Mitel Ipera IP PBXs and the documentation for the AllPoint Messenger integration with
NuPoint Messenger.

• The section "Software Compatible with OnePoint Messenger 2.0" now lists Internet Explorer
5.0 or better as required on the Exchange Server to support Web access to messages.

• The section "Product and Configuration Notes" contains notes on the Export button of
Statistics Reporting Program, "Important Safety Information—Grounding (Earth)" and lists
sources of updated documentation for previous product and configuration notes.

Installation Notes

This section is divided into six groups:

• Installation Notes for Service Pack 1

• General Installation Notes

• Turnkey Telephony Server Installation Notes

•
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Installing or Reinstalling Base Releases

• Upgrading from OnePoint Messenger 1.1

• Removing OnePoint Messenger 2.0

Installation Notes for Service Pack 1
Before installing Service Pack 1, read the notes in this section and in the sections "General Installation
Notes" and "Installing or Reinstalling Base Releases". OnePoint Messenger 2.0 Service Pack 1 contains a
full build of OnePoint Messenger. You can run it on a bare Windows NT 4.0 Server to create the
Telephony Server, or you can run it in SmartUpdate mode on a Telephony Server that already contains
OnePoint Messenger 2.0 software. To install it on a bare system, follow the directions in the OnePoint
Messenger Installation Guide for installing OnePoint Messenger on bare systems.

To use SmartUpdate to install (these instructions are from Chapter 5 in the OnePoint Messenger
Installation Guide) Service Pack 1:

1. Use Telephony Server Monitor (TSMon) to stop telephony services on the Telephony Server. In
TSMon, change the start mode to manual until the update is completed. For details on TSMon, see
“Using TSMon to Start and Stop Telephony Server” in Chapter 5 of the OnePoint Messenger
Installation Guide.

2. Insert the OnePoint Messenger 2.0 Service Pack 1 CD-ROM. The OnePoint Messenger Installation
Program starts and checks for OnePoint Messenger on the system.

3. If the Installation Program finds OnePoint Messenger on the system, it invokes SmartUpdate, which
offers to back up the configuration files. If you do not accept, SmartUpdate skips the backup. If you
accept, SmartUpdate backs up the files. If SmartUpdate cannot find a file, it displays an alert. The
backed up files are stored in “SmartUpdate.zip.” SmartUpdate also creates the SmartUpdate.log file,
listing the backed up files. Both files are stored in \OnePoint Messenger\bin.

4. When the installation is complete, SmartUpdate restores the configuration files, with SmartUpdate.zip
as a permanent backup.

5. If you did not previously set up the Mail Transport Agent (MTA), as described in Procedure 4 in
Chapter 3 of the OnePoint Messenger Installation Guide, and you now want to do so, or if you want
to revise your Internet gateway address:

a. Click the Windows Start button, then choose Programs, then Vintraserver, and installservice.

Alternatively, start Internet Explorer. In the Address field, enter:

http://localhost:1967/mta.html

b. Press [Enter].

c. If an Enter Network Password screen appears, for User Name, enter TSAdmin (use the same
case as you used to log in), and for Password, enter the TSAdmin password.

d. Optionally, click Save password in your password list.

e. Click OK. The Mail Transport Agent Administration Web page appears.

f. Click Internet MTA Config. The main MTA Configuration page appears.



OnePoint Messenger 2.0 Release Notes, Revision D

P/N 56000301,Rev. D, December 14, 2000 Page 10

g. For line 1.1, “VPIM Domains for which you wish to receive mail”, enter your Telephony Server
computer name and your Internet domain name in the form:

<Telephony Server machine name>.<Internet domain name>

For example, if your Telephony Server computer name is “TServr” and your Internet domain name is
“bluescreen.com,” then enter:

TServr.bluescreen.com

h. Optionally, select the checkbox for line 1.9, “Enable Delivery Log”.

i. Click Create sendmail.cf.

j. On the success screen that appears, click MTA Administration Main Page. The MTA main page
reappears.

k. Click Stop MTA. A success page appears.

l. Click Back to return to the MTA main page.

m. Click Start MTA. A success page appears.

n. Click Back to return to the MTA main page.

o. Click Get Current Status. A success page appears with:

ServiceStatus – mta: RUNNING

p. Click Back to return to the MTA main screen, then close Internet Explorer.

6. Run the Configuration Wizard to update the software on the Exchange Server. Follow the steps
described in “Procedure 5. Running Configuration Wizard to Integrate Telephony Server with
Exchange Server” in Chapter 3 of the OnePoint Messenger Installation Guide.

7. Run Directory Initialization, as described in “Procedure 6. Running Directory Initialization” in
Chapter 3 of the OnePoint Messenger Installation Guide.

8. Inspect and edit configuration settings, as necessary, then test the operation of services in manual mode
before returning TSMon to automatic mode.

9. Remove the old OnePoint Messenger Desktop Client from client systems and install the new client, as
described in Chapter 3 of the OnePoint Messenger Installation Guide, Chapter 2 of the OnePoint
Messenger User Guide, or Chapter 6 of the OnePoint Messenger Getting Started Guide.

General Installation Notes
Those that are pertinent to all conditions are included in this first group of general installation notes. The
other groups contain additional notes for specific conditions. For each specific condition, use the relevant
installation guides, amending the instructions with the general installation release notes and the group of
release notes for the relevant specific condition. Notes in this section that are new in this version of the
Release Notes are underlined.

The following installation notes relate to all installation conditions. Use these notes along with the
installation guides and release notes described in the sections below that pertain to your conditions:

• Configuration Wizard: While running the OnePoint Messenger Configuration Wizard, do not edit a
Unified Messaging tab in the Exchange Administrator program or make changes using the Internet



OnePoint Messenger 2.0 Release Notes, Revision D

P/N 56000301,Rev. D, December 14, 2000 Page 11

Information Server Administrator program. Close Exchange Administrator on all Exchange Servers on
the Exchange Site and stop the Internet Information Server and WWW Publishing services until you
have finished running Configuration Wizard.

• OnePoint Messenger Desktop Client — Do not install on the Telephony Server: Installing the
OnePoint Messenger Desktop Client on the Telephony Server overwrites other critical settings and will
require full reinstallation of OnePoint Messenger.

• Message Delivery: The Message Delivery telephony application must run on one Show N Tel line. For
consistency in providing remote support, assign it to SNT line 50 (On some Telephony Server turnkey
systems, Message Delivery is preassigned to SNT line 512; move it to line 50). For details on
assigning applications in Show N Tel, see Chapter 4 in the OnePoint Messenger Installation Guide, or
see the OnePoint Messenger integration guide specific to your PBX.

• NMS line cards with AFC card: When using the Mitel AFC card with Natural MicroSystems (NMS)
AG-0 cards (AG-8 card without SIPPs ) or AG-24 cards in the Mitel SX-2000 integration, set up the
AFC card as the MVIP clock source. In ag.cfg, set any AG-0 or AG-24 card ClockRef = MVIP. For
directions on editing ag.cfg, see the NMS card instructions, summarized in Chapter 3 of the OnePoint
Messenger/SX-2000 Integration Guide and in Appendix A of the OnePoint Messenger Installation
Guide.

• NMS line card installation with AG Config: The Validate button in AG Config becomes inactive
after the first attempt at validating the AG configuration. To use the Validate button again, close AG
Config and restart it.

• NMS line card drivers: If the NMS drivers do not start, run the following command from a DOS
prompt:

agcfg -f C:\NMS\ag\cfg\ag.cfg

• NuPoint Messenger 7.0 RSD 2: when integrating OnePoint Messenger with NuPoint Messenger 7.0 to
create an AllPoint Messenger hybrid environment, use NuPoint Messenger 7.0 Revision Support Disk
2 (RSD 2).

• VPIM: Prior to loading OnePoint Messenger, check that the Telephony Server is assigned a static IP
address and that the Domain Name Server (DNS) is configured to reflect that IP address. Add the IP
address of the DNS to the DNS tab of the Telephony Server's TCP/IP Properties. To do this after
installation, stop and restart telephony services.

Turnkey Telephony Server Installation Notes
When installing a turnkey TS800 Telephony Server (i.e., OnePoint Messenger 2.0 comes factory-installed
on the TS800), follow the directions above along with the printed OnePoint Messenger Getting Started
Guide that accompanies the system and the integration guide for your PBX. All of the guides are in
Acrobat 3.0 PDF format on the OnePoint Messenger CD-ROM in the \Documentation directory. For
details, see the section "OnePoint Messenger 2.0 Documentation Set", below.

Note: As stated in the OnePoint Messenger Getting Started Guide, the turnkey Telephony Server is
configured at the factory with a local administrator name of "administrator" with password of "rmx250".
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Installing or Reinstalling Base Releases
When installing OnePoint Messenger 2.0 on a bare system, or when reinstalling OnePoint Messenger, use
the general installation notes listed above along with the OnePoint Messenger Installation Guide and the
integration guide for your PBX. As noted above, the guides are in the \Documentation directory of the
OnePoint Messenger CD-ROM.

Upgrading from OnePoint Messenger 1.1
In addition to the installation notes listed above, use the following installation notes when upgrading from
OnePoint Messenger 1.1 to OnePoint Messenger 2.0, along with Chapter 5 in the OnePoint Messenger
Installation Guide or the OnePoint Messenger Getting Started Guide, as appropriate.

Upgrading the Telephony Server
For sites running OnePoint Messenger 1.1 on a TS800 that contains less than a 550 MHz CPU and 256
MB of RAM, it is necessary to upgrade the Telephony Server hardware. A new TS800, containing
OnePoint Messenger 2.0, will be sent to the customer site in exchange for the customer's existing TS800.
The TS800 upgrade package is essentially the same as a new turnkey system, except that it contains no
linecards. The on-site technician must move the linecards from the old system to the new system, as
discussed below.

License: When upgrading from OnePoint Messenger version 1.1 to 2.0, you must get a new license, not
only because the new hardware has a new server code, but also because there are new licensed features in
OnePoint Messenger 2.0. The license comes installed on the new system.

Note: To add new TUI prompt language sets beyond those allowed by the original license, purchase a new
license, then run the OnePoint Messenger Installation Program with the SmartUpdate option. For details,
see Chapter 5 of the OnePoint Messenger Installation Guide.

Upgrading the Exchange Server
Exchange Server hardware: The Exchange Server hardware used to support OnePoint Messenger version
1.1 is adequate for version 2.0.

Exchange Server software: Exchange 5.0 support is not included with OnePoint Messenger 2.0, which
has only been tested with Microsoft Exchange 5.5.

As detailed below, before installing OnePoint Messenger 2.0 software on the Exchange Server, uninstall
versions of OnePoint Messenger previous to version 2.0. Also remove the mailboxes for the Outside
Caller, TS Test User and TS Admin. It is not necessary to back up user greetings or messages. After
uninstalling version 1.1, use Configuration Wizard and the Web Client Installation Program to install
OnePoint Messenger 2.0 on the Exchange Server.

User profiles: OnePoint Messenger 2.0 has the same 10 default Class of Service (COS) names and settings
that come as defaults with OnePoint Messenger 1.1. However, when you purchase the VPIM feature
license, the feature "Enable VPIM Addressing" is added to each COS and enabled by default in each COS
except "Student". All user profiles are preserved in Microsoft Exchange when you upgrade to OnePoint
Messenger 2.0, and any user profile that has a COS using one of the 10 default COS names will keep its
revised settings. Any profile that has a COS that you renamed in OnePoint Messenger 1.1 will have the
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default COS permissions assigned to the COS as originally named. For details on editing the OnePoint
Messenger 2.0 COSs to match your 1.1 COS settings, see above.

To Perform the Upgrade to OnePoint Messenger 2.0:
1) Gather the OnePoint Messenger 1.1 software settings from your old Telephony Server:

a) In Telephony Server Admin, record the settings on each tab that you want to save. The most
important settings usually are:

• (On the System Parameters tab) Automated Attendant, Fax on demand, and Message Center
pilot numbers, default fax number, Attendant mailbox, and Operator extension

• Business hours

• COS names and settings changed from the version 1.1 defaults; for details, see "To perform
the COS migration" and "User Profiles", below.

• Dialing plan

• Fax on Demand document descriptions

b) In Network Properties, record the:

• Computer name

• Domain

• TCP/IP properties: Telephony Server IP address, subnet mask, gateway address, DNS
information, WINS

c) Record the information in the Hosts file (in C:\winnt\system 32\drivers\etc)

d) Inspect the linecard settings:

• (In MiTAI) AFC card IRQ, AFC Driver, base memory address (factory defaults are IRQ 11,
memory 300)

• (In the Brooktrout Fax Card Configuration dialog) Number of ports, IRQ (factory defaults
are IRQ 10, no DMA)

• (In AG Config) AG-0 card IRQ and base memory address (factory defaults are IRQ 5, 02C0
base memory (first card; second card is 22C0)

e) In SNT Manager:

• From Configure CTI > Device Map, the trunk numbers (must match the PBX trunk
numbers). Note that, in OnePoint Messenger 2.0, the trunk device type is "Trunk" instead of
"Show N Tel Line".

• > SNT Manager Setup, record the line assignments.

f) In License Install, record the number of used and available features, then, after installing OnePoint
Messenger 2.0, verify that the new license has at least those original features.

2) Record the linecard slot positions from your old Telephony Server. Ideally, you will move those cards
directly from the old to the new computer, to minimize handling and misplacement.
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3) To move the linecards:

a) Stop telephony services.

b) Shut down the Telephony Server.

c) Remove the left side panel and bottom plate (left side = looking at the TS800 from the front).

d) Disconnect the fiber cable from the AFC card.

e) Remove the MVIP cable from the top of the linecards.

f) Open the replacement server, as above.

g) Remove a card from the old server and move it to the same slot in the new server. If you are
adding cards at this time, refer to Appendix B in the OnePoint Messenger Installation Guide for
details on installing cards.

h) If there are cards in the replacement server, verify that the cards are seated and screws are in place.
Check their IRQ, base memory address, and MVIP termination settings, in order to resolve
conflicts with cards being installed.

i) Install the MVIP cable on all cards in the MVIP array.

j) Install the bottom plate and side panels on the server.

k) Connect fiber, power, and Ethernet cables.

4. To uninstall OnePoint Messenger 1.1 from the Exchange Server (for details, see Chapter 5 in the
OnePoint Messenger Installation Guide):

a) Stop telephony services on the Telephony Server.

b) Stop mail services on the Exchange Server, including IIS.

c) Open Exchange Administrator in raw properties mode.

d) Delete the Outside Caller, Tsadmin, and Test User accounts from the Recipients list.

e) Remove OPM Gateway Extension and Unified Message from <your Exchange Site name> >
Configuration > Add-ins.

f) Delete Fax and VPIM from Configuration > Addressing > E-Mail Address Generators.

g) In the Exchange Administrator main screen tree view, select Configuration, then select Site
Addressing in the Display Name panel. From the File menu, choose Raw Properties. In the
Object attributes list in the Site Addressing Properties dialog, select Gateway-Proxy. In the
Attributes values list, select any value that begins with either FAX:@ or VPIM:@, then click
Remove. Do this with each such value in the list.

h) Delete Fax Gateway and Unified Message VPIM Gatewayfrom Configuration > Connections.

i) Select Recipients. From the File menu, choose Raw Properties. In the Recipients Properties
dialog, select Extension-Name-Inherited from the Object attributes list. Delete CVUMail from
the Attribute values list.

j) In Windows NT Explorer, go to \exchsrvr\Add-ins. Delete the cvUMail directory. If Explorer
cannot delete the directory, open the Services applet in Control Panel, and stop IIS Admin
Services.
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k) Use the Add/Remove Programs applet in Control Panel to remove OnePoint Messenger Web
Client.

l) Set the Exchange forms author permission for reinstalling OnePoint Messenger:

5. If you are replacing the Telephony Server, the domain administrator must remove it from the host list
in Server Manager even if you are giving the new Telephony Server the same computer name.

6. Follow Chapter 4 in the OnePoint Messenger Getting Started Guide to set up the new Telephony
Server (it uses the same local administrator name "administrator" and password "rmx250" (case
sensitive) described in that guide) and to install software on the Exchange Server. Then see your PBX
integration guide.

NOTE—AFC driver: The replacement TS800 comes with MiTAI 7.5.3 and several AFC drivers. For
the SX-2000 PBX, verify that the AFC driver on the Telephony Server is the one required by the PBX
load. Check the SX-2000 Field Change Instructions (FCI) to determine the appropriate AFC driver.
To download the FCI or an AFC driver, access Mitel Online at the URL http://www.mitel.com.

For the AFC driver, log in, click Tech Support, then Software Downloads, then Mitel OnePoint
Messenger, and then AFC Drivers.

NOTE—Renaming the Telephony Server: To rename the Telephony Server, see "Renaming the
Telephony Server" in Chapter 4 in the Getting Started Guide. To validate correct system operation
after replacing and renaming the server, call the Automated Attendant, then enter an extension. The
Telephony Server name may not be correctly identified updated to its configuration database or
identified correctly on user profiles if the TUI replies that the extension is invalid. In Exchange, open
the Unified Messaging tab of the OnePoint Messenger recipient to verify that the new Telephony Server
name is correctly identified. Attempt to create a new user; if entering a mailbox or extension number
results in an invalid-number error message, your new Telephony Server name is not correctly
identified.

NOTE—Restarting Exchange: After installing the Exchange extension and Web Client software, you
must shut down and restart the server. In the Services applet in the Control Panel, stopping Exchange
Attendant first will accelerate the shutdown.

System greetings and fax documents: To move fax documents or system greetings from your OnePoint
Messenger 1.1 Telephony Server to your OnePoint Messenger 2.0 Telephony Server, back them up from
their directories before uninstalling OnePoint Messenger. To import the saved files into OnePoint
Messenger 2.0, see the sections "Greetings and Prompts" and "Fax Documents" in Chapter 3 of the
OnePoint Messenger Administrator Guide.

To perform the COS migration:

1. Record the settings of any COS that you renamed in OnePoint Messenger 1.1.

2. Edit the settings in the equivalent OnePoint Messenger 2.0 COS to match (i.e., "equivalent COS" is the
COS with the name that your renamed OnePoint Messenger 1.1 COS originally had.) You can also
revise the 2.0 COS name to match the 1.1 COS name.

3. At this point, all of your users have the COS features that they had in version 1.1. In addition, they
have the Call-Me and VPIM features. To restrict use of those features, you must deselect them from
one or more COSs, then reassign the unlucky users to those COSs. For details, see "Class of Service"
in Chapter 3 of the OnePoint Messenger Administrator Guide.
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Upgrading User Systems
To upgrade client systems from OnePoint Messenger version 1.1 to version 2.0, first install OnePoint
Messenger 2.0 on the servers, then uninstall version 1.1 from a desktop client before installing version 2.0.
See Chapter 2 in the OnePoint Messenger User Guide for details on removing and installing the client.
“Procedure 12. Setting Up and Running the Test User” in the OnePoint Messenger Installation Guide also
has details on installing a client.

Removing OnePoint Messenger 2.0

For details on removing OnePoint Messenger 2.0 from servers and clients, see "Removing OnePoint
Messenger" in Chapter 5 of the OnePoint Messenger Installation Guide. In addition:

On the Telephony Server, to remove OnePoint Messenger 2.0:

1. Use the Add/Remove applet in Windows NT Control Panel to remove OnePoint Messenger

2. Optionally, use the same procedure to remove the supporting applications installed with OnePoint
Messenger, including Active Call, Data Access Objects (DAO), Borland, Show N Tel, Brooktrout,
Vintra Mail Transport Agent, WinFT, and Greenleaf Commx.

3. In Windows Explorer, remove the …\Program Files\Mitel directory.

4. If you have removed the supporting software in Control Panel, you can delete the companion
directories. At the root, those include Acrobat, NMS, and SNT. Within the Program Files directory,
they include Borland, Brooktrout, Greenleaf, and Vintra.

Feature Enhancements

The following feature enhancements are introduced in OnePoint Messenger 2.0 Service Pack 1:

Cvviewmsg.exe Utility

The Cvviewmsg.exe utility is in the OnePoint Messenger Installation Program provided by Service
Pack 1. The utility is useful for inspecting "GMD" files, especially good for troubleshooting
VPIM messaging. It is stored in the \bin directory under \OnePoint Messenger on the Telephony
Server.

Prompt Languages Now Include Dutch and Canadian French

Dutch and Canadian French prompt sets are now available, at both the system and mailbox level,
bundled with the base software or as add-on languages. These two languages join American
English, British English, and Latin American Spanish as available prompt languages.
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For a language to be available to the administrator to assign to system or mailbox prompts, you
must either designate it as the desired language in the base software, or install it as a licensed
option.

Tracebak.cfg Provides SNT Trace Log Limit (CR 4000-114040)

The Tracebak.cfg configuration file has been added in the Telephony Server directory C:\SNT. It
enables the administrator to control the size of the log created by SNT Trace.

To edit Tracebak.cfg, open it in Notepad. On the second line of the file, enter the desired
maximum size of the log (no limit other than available disk space; the default is 100 MB). On the
third line of the file, enter the maximum number of logs to save (no programmed limit on the
number of logs; default is 5). To enable the configuration changes, click Disable Tracing (if
tracing is running) in SNT Trace, then click Enable Tracing.

The first log, named Trace.log, is created in C:\SNT. When it reaches the maximum specified
size, it is automatically renamed trace1.bak, and a new Trace.log is created to collect the most
recent tracing data. When Trace.log fills up again, trace1.bak becomes trace2.bak, and Trace.log
becomes trace1.bak. The file renaming process repeats up to the number of backup files specified,
and then the system begins to overwrite the oldest file. For example, if the default of 5 is used, six
trace files can be automatically created, and the next log created forces the system to overwrite
trace5.bak. To keep trace5.bak, either rename it or move it.

For a summary of client features, see Chapter 1 of the OnePoint Messenger User Guide. For more on
administrative features, see Chapter 1 of the OnePoint Messenger Administrator Guide.

Software Compatible with OnePoint
Messenger 2.0

The following list contains the revision levels of third-party software that is required for OnePoint
Messenger 2.0.

• On the Telephony Server:

• Windows NT4.0, with Service Pack (SP) 5 or 6a

• Outlook98

• Internet Explorer (IE) 5.0+

• MiTAI 7.5.3 (for SX-200 or SX-2000 PBX integrations)

• Show N Tel 4.4

• On the Exchange Server:

• Windows NT4.0, with SP5 or 6a and Option Pack 4.0 (Internet Information Server 2.0)

• Exchange Server 5.5, with SP2 or SP3
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• Internet Explorer (IE) 5.0+ (if you want to provide Web browser access to messages)

• On client PCs:

• Windows 95, Windows 98, or Windows NT Workstation 4.0 running SP 5 or 6a

• Outlook 98 or Outlook 2000

• IE 5.0+ or Netscape 4.7

The revision levels of the listed third-party software are not necessarily the only compatible revisions,
simply the levels tested and supported.

Issues Fixed in Service Pack 1

This section lists the issues fixed in Service Pack 1. The first group of issues contains those listed
as known issues in previous versions of the Release Notes. The second group of issues contains
those not previously listed. For a summary of the fixed issues, see the introductory section to this
document "New in this Revision D of the OnePoint Messenger 2.0 Release Notes".

Previously Listed Known Issues Fixed in Service Pack 1

This section contains notes about issues fixed in OnePoint Messenger 2.0 Service Pack 1 that had
appeared as known issues in previous versions of the OnePoint Messenger 2.0 Release Notes. See
the next section, Previously Unlisted Issues Fixed in Service Pack 1, for notes about issues fixed in
Service Pack 1 that had not been previously published as known issues.

AG Config, Benign Error Message (CR 4000-113769)

When AG Config was used to configure an NMS card, the following benign error message might
appear upon saving: "use: net helpmsg 1060 to check the error."

FAX: No Answer after Receiving Fax (CR 4000-113995, CR 4000-114000)

After the SendFax port went on-hook after transmitting a QuickFax or a fax from a fax machine to
a OnePoint Messenger user's extension, the Telephony Server port receiving the fax might remain
engaged for up to two minutes. A call routed to that port during that period would cause the port
to ring without answering.

Isolated AG-0 Ports Answer with Dead Air (CR 4000-113812)

In rare instances with two AG-0 cards installed, a port might stop playing greetings. Then, every
time someone tried to leave a message or a user tried to check a message on that port, it answered
with dead air—no greeting or prompt plays.
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Language Defaults (CR 4000-113653; also CR 4000-113996)

When both U.S. English and another TUI prompt language were installed, changing the default
mailbox prompt language in the Mailbox Defaults page of TS Admin from U.S. English to the
other language would not be reflected in the Unified Messaging tab of Exchange.

MWI Restart when Exchange Rebooted (CR 4000-113977)

When the Exchange Server was rebooted, the MWI service on the Telephony Server would
occasionally fail.

RPC Error when Editing User Profile (CR 4000-113847)

When editing the Unified Messaging tab of a user in Exchange, a benign error message
occasionally appeared: "cannot notify Telephony Server of changes. The RPC server is
unavailable. Do you want to continue?" You could save the profile in Exchange, but when you
dialed the Message Center, the new mailbox might not yet be available. This event occurred when
the Directory Access Service on the Telephony Server was not immediately available to accept
updates.

SDR: # and * Keys with "Allow cut through extensions" (CR 4000-114009)

When “Allow cut-through extensions” was selected on the General tab of the SDR application, the
# and * keys would not provide complete functionality when using the SDR menu.

SDR: Eight-second Delay during Transfer (CR 4000-114010)

With the SDR Application enabled, when a caller dials a valid extension, the system may delay up
to eight seconds before transferring the call. During that period the line is silent.

SX-2000: System Recovery after Loss of MiTAI Link (CR 4000-113992)

In a Mitel SX-2000 integration, the Telephony Server would answer with dead air after a
temporary outage of the MiTAI Link, such as from a reboot of the PBX. Subsequent calls made
would cause the ports to not answer in various states (e.g. answering call, user logging in, etc.).

Text-to-Speech (TTS) Dictionary Editing (CR 4000-113874)

The Text-to-Speech (TTS) Dictionary was not editable, because the sound card is not enabled on
the TS800, and the software that allows editing the TTS Dictionary on a remote PC was not
working. The remote editing capability is now enabled.

TUI: TTS Announces Name of Reply Recipient (CR 4000-113923)

When answering a unified message from another user, the TUI announced the name of the recipient
using Text-to-Speech (TTS) rather than the recipient's recorded name. With Service Pack 1, the
recorded name of the recipient plays as it should.
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Previously Unlisted Issues Fixed in Service Pack 1
This section contains details on issues addressed by Service Pack 1 that had not been noted in previous
editions of the Release Notes.

Attendant Extension Highlighted when Attendant Deselected (CR 4000-114111)

In the Attendant Configuration page of TS Admin (Unified Messaging Snap-in to Microsoft
Management Console), when Attendant Enabled (enabling the Operator) was deselected, the
Attendant Extension field remained available to edit. Now, when the administrator deselects
Attendant Enabled, the Attendant Extension field becomes unavailable to edit (is grayed out).

Attendant Mailbox Available from the Automated Attendant (CR 4000-113889)

When enabled, the Attendant mailbox now works for both the Automated Attendant and Message
Center. With the Attendant mailbox enable, after business hours, when callers do not respond to
TUI prompts, the TUI then prompts the caller to "Please leave a message at the tone", and the
message is placed in the Attendant mailbox.

Create the Attendant mailbox in Exchange Administrator, then designate and enable it as the
Attendant mailbox on the System Information page of TS Admin. For details, see the section
"System Information" in Chapter 3 of the OnePoint Messenger Administrator Guide.

Business Hours Did Not Control Greeting Correctly (CR 4000-113726)

1. If the Telephony Server administrator sets the business hour start or end time to 12:XX A.M.,
TS Admin would change it to P.M., and vice versa.

2. If the business start hours are set between 12 A.M. and 12:59 A.M., the system would prompt "I
am sorry. There is no attendant available" when a caller dialed 0 during A.M. business hours.

Callback Number Prompts (CR 4000-114070)

After a caller leaves a message, the TUI prompts the caller to press 4 "to input a callback number".
Previously, if the caller pressed 4, entered a callback number, and then did not press #, the TUI
played the wrong prompts.

Correction to Installation of DAO (CR 4000-113908)

During the installation of OnePoint Messenger on the Telephony Server, the installation of DAO
3.5 would freeze occasionally. That part of the installation sequence has been removed from the
OnePoint Messenger Installation Program provided by OnePoint Messenger 2.0 Service Pack 1.

Correction to Installation of SNT SR 2 Baypt24NMS Patch (CR 4000-113907)

At the end of the OnePoint Messenger installation sequence on the Telephony Server, the
Installation Program installs a patch called "Show N Tel 4.4.0 SR 2 for NT Build106
Baypt24NMS". A "General file transfer" error message would occur if you attempted to start the
installation of the patch before the last screen of the previous part of the installation appeared. The
installation provided by OnePoint Messenger 2.0 Service Pack 1 runs without that error.



OnePoint Messenger 2.0 Release Notes, Revision D

P/N 56000301,Rev. D, December 14, 2000 Page 21

Directory Initialization Program Warning to Stop Services (CR 4000-113994,
CR 4000-113991)

Now, when the administrator starts the Directory Initialization program, a warning appears to use
TSMon to stop telephony services before running Directory Initialization.

Faxes Delivered in Walkaway Fax or DID Fax Call (CR 4000-114041)

OnePoint Messenger now reliably delivers a fax to a mailbox when sent from a Walkaway fax call
or from a DID fax call.

Fax Tone Generated for Fax Sent by Desktop Client (CR 4000-114136)

OnePoint Messenger now sends the correct CNG fax tone when a user sends a fax to a fax
machine using the Desktop Client.

Group Configuration Node of TS Admin, Plus Sign (CR 4000-114114)

The plus sign (+) next to the Group Configuration node in the TS Admin tree (the Unified
Messaging Snap-in to Microsoft Management Console) now appears when MMC launches.
Previously, it did not appear until the node was double-clicked.

Logging into Mailbox That Has No Extension (CR 4000-113859)

A user with unified messaging permissions and a mailbox that has no extension entered in the
Telephone Extension field can now log into his or her mailbox from a telephone. Because the
system cannot identify the user with a particular extension, when the user calls in to the Message
Center, the system either prompts with the general greeting or prompts the user for the passcode of
another user. The user must, within the timeout period specified by the administrator, press star
(*), then enter his or her mailbox number. The TUI then prompts the caller for the passcode for
the requested mailbox.

PIN (Prefix String) For a Pager (CR 4000-113905)

Paging with PIN access did not work properly. OnePoint Messenger would dial the pager number
without first dialing the PIN. Service Pack 1 fixes that problem.

Port Does Not Answer (CR 4000-114052, CR 4000-114075)

Intermittently, ports running the TelephonyServer application would terminate and return to an idle
condition. Restarting the line via the SNT Manager would bring the line back into service. In
other cases, the system would announce to a caller "The system is experiencing technical
difficulties. Please try again later." This might happen when callers press # at inappropriate
times. Service Pack 1 eliminates many, if not all, connection failures based on those conditions.

SDR Option "Deliver Fax to Caller" Prompts (CR 4000-114042)

The Single Digit Routing (SDR) menu option "Deliver Fax to Caller" now plays its prompt when
used when AutoRecep is assigned to a Show N Tel line.
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Timeout Value Setting for Caller Response (CR 4000-113169, CR 4000-113656)

The timeout value set on the System Limits page by the administrator now controls the user
response timeout when a user is managing a mailbox.

Timestamp on VPIM Messages (CR 4000-113984)

The timestamp on VPIM messages is now accurate. Previously, the timestamp decreased by one
hour for each reply during Daylight Savings time periods.

TMP Files Cleaned from Telephony Server (CR 4000-114028)

TMP files remained unnecessarily on the Telephony Server after completing their purpose, such as
making fax transmissions. Now, when the Telephony Server administrator stops services through
TSMon, the TMP files in the \TEMP and \Windows directory are automatically deleted.

Known Issues and Limitations

In addition to the installation and configuration notes that appear in their own sections in this
document, this section lists known operational issues and limitations of the software that are
scheduled to be resolved.

Issues added to the list in this version of the Release Notes are underlined.

Known Issues

100% CPU Utilization (CR 4000-113918)

The application Sntrun.exe uses up 100% of the CPU when a fax becomes stuck in the Fax
Gateway queue. This can happen when virus-checking software scans the queue. Removing the
Fax and VPIM gateways from the scan list is documented in Chapter 2 of the OnePoint Messenger
Administrator Guide.

Brooktrout Fax Configuration Wizard, Inconsistent Operation (CR 4000-114019)

The Brooktrout Fax Configuration Wizard has an extra screen when run from the Windows Start
menu as opposed to when it runs within the OnePoint Messenger Installation Program. For details
on the Brooktrout Fax Configuration Wizard that runs from the Windows Start menu, see the
"Product and Configuration Notes" section, below.

Call Answering, Ring Delay (CR 4000-113706)

The Telephony Server answers calls on the second ring in an analog configuration (i.e.,
EDLI/SMDI PBX integrations).
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Directory Synchronization Fails if Exchange Server Is Down (CR 4000-114023)

The full directory synchronization between the Telephony Server and the Exchange Server occurs
at 2 A.M. each night. If the Exchange Server is down at that time, the Telephony Server directory
will be erased.

There are two workarounds. If you know that the Exchange Server will be unavailable, you can
stop telephony services on the Telephony Server at that time. Alternatively, if you discover that the
automatic synchronization has failed, you can manually invoke directory synchronization. For
details on directory synchronization, see Appendix A in the OnePoint Messenger Administrator
Guide.

Directory Synchronization Fails for Mailbox Named with Digits (CR 4000-114161)

If you enter a user name that contains only digits when you create a mailbox in Exchange set up
with unified messaging, Exchange will accept the name and create the mailbox, but the directory
synchronization to the Telephony Server will fail to include that mailbox. Running the Directory
Initialization program will result in the message "Add to DB failed for user".

When you create a user name (on the General tab of the mailbox profile), you may include digits in
any part of the name (beginning, ending, etc.), but the name must contain some letters for the
directory synchronization to include that mailbox. For example "Charlie at6301" and "6301
Charlie" are valid names.

Holiday Definitions in TS Admin (CR 4000-113914)

When creating a New Holiday, it is necessary to restart Telephony Server services in order for the
holiday period to be activated.

Installation Delay (CR 4000-114268)

A delay of about one minute occurs at the end of the OnePoint Messenger Installation Program
sequence on the Telephony Server. After you click Finish on the Setup Complete screen of the
SNT SR 2 Baypt24NMS patch, the screen closes, then the final message appears after about a
minute: "OnePoint Messenger was successfully installed. Press OK to reboot the system."

Message Delivery Page Prompts Incorrect (CR 4000-113926)

Under some conditions, when a user's pager notification is set up with the Message Delivery
option, the TUI may play the wrong prompts when the paged user attempts to play the message.

Only if your users report incorrect paging prompts and your system language is U.S. English, a
possible solution is to change the template number to -1 on the Language Parameters tab of Show
N Tel Setup:

1 Start Show N Tel Manager.

2 From the Tools menu, choose Setup.

3 Select the Language tab.
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4 Select the row that contains EngUS.lng.

5 Change the value in its Template Number field to -1, as shown in the figure below.

If you subsequently assign a different system language in TS Admin, you do not need to edit this
Language Parameters tab.

Show N Tel (SNT) Phone System Tone Table (CR 4000-113858)

This problem is also known as "Dialtone on disconnect fails when hang up during greeting."

Default.ton is one of the default SNT settings for all PBX integrations using Enhanced Data Link
Integration (EDLI) software. In some cases (found, so far, only with the Fujitsu 9600), the
default.ton file does not provide the correct PBX "clear down" tone to indicate that the caller has
gone on-hook (i.e., ended the call). Messages left from the TUI for OnePoint Messenger users
include a long dial tone at the end. The following is a workaround to correct that problem:

1. Get information about the PBX clear down signal from the PBX technician.

2. On the Telephony Server, in Show N Tel Manager, from the Tools menu, choose Show N Tel
Setup.

3. Select the Phone System tab.

4. In the Phone System List area, select your phone systems (for example, for the default Fujitsu
9600 phone system, select Fujitsu9600), then click Edit.

5. In the Phone System Definition window that appears, select the Tone Table tab, shown below.

6. In the Select Tone Table area, select the tone table to match your PBX signaling. Select:

• Busy.ton if the switch provides a busy tone as the clear down indicator

• Fastbsy.ton if the switch provides a fast busy tone as the clear down indicator

• Do not select Dial.ton for a normal dial tone. Select Default.ton instead.
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7. Click OK.

TUI: System Erroneously Announces "Your message sent…"(CR 4000-113677)

When the Exchange Server is down or the mailbox size limit is reached of either the Outside Caller
mailbox or the recipient, the TUI cannot deliver a message to a user but still announces "Your
message sent."

Limitations of the Software
This section contains notes about feature limitations not covered in the guides. As opposed to the problems
listed in the Known Issues section, these limitations are not planned for modification in upgrades of
OnePoint Messenger 2.0. The text for the item "Fax Document Subject" is underlined to highlight it as the
one new limitation noted in this version of the Release Notes.

Call-Me/Meet-Me Session Termination

In order to release ports for other uses, Windows 95 users need to terminate Call-Me/Meet-Me
sessions by selecting the Terminate Call-Me/Meet-Me button or menu item in the Tools menu in
addition to hanging up the phone. If they simply hang up, ports may not be released until the
timeout limit.
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Fax Document Subject

Fax documents created by the Unified Fax Printer are limited to 45 characters in their Subject
lines.

Fax on Demand

Fax on Demand in OnePoint Messenger 2.0 differs substantially in operation from OnePoint
Messenger 1.1. It now runs as a Single Digit Routing (SDR) option. The option to download a
list of the documents available through the Fax on Demand service is no longer automatic. To
make the list available, manually create the list as a fax document, and make the document
available as a menu option in the SDR table. For details, see the Fax on Demand sections in
Chapters 3 and 4 and Appendix D of the OnePoint Messenger Administrator Guide.

Greetings and Prompts Recording Options

Record greetings and prompts in TS Admin (the Unified Messaging Snap-in) on a remote system
only. Recording directly on the Telephony Server is unavailable.

You can create a greeting or prompt on another system using that system's multimedia capability.
Then you can use pcAnywhere to copy the audio file to the Telephony Server and import the file
into a Greetings page in TS Admin.

When importing an audio file, TS Admin converts the file, if necessary, to OKI format and stores
the resulting greeting in its configuration database. The source file is unchanged. In addition to the
native OKI format, you can record in these formats:

• 8 kHz, 8 Bit PCM

• 8 kHz, 16 Bit PCM

• 8 kHz, 8 Bit Mu-Law

• 8 kHz, 4 Bit IMA ADPCM

New Holiday Definition

Page Name and Description Updates: A New Holiday page does not display the page name and
description in the MMC Results pane until the page has been opened and closed again.

Online Help

On the Telephony Server, in addition to task-specific help (Admin_tc.hlp), there are two
comprehensive online help systems for all OnePoint Messenger server applications:

• Admin.hlp is a WinHelp file called by the OnePoint Messenger applications developed
previous to OnePoint Messenger 2.0.

• TSAdmin.chm uses the newer Microsoft HTML style of online help. Along with duplicating
the help topics of Admin.hlp, it provides help for TS Admin (the Unified Messaging Snap-in to
MMC). The context help usually available at the dialog level from a Help button or at the
field level from the F1 key or the question mark button is not yet provided.
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Outlook Next and Previous Buttons

In the Read Unified Message form and in QuickPick, a Microsoft Outlook bug limits the use of the
Next and Previous buttons provided by Outlook to open any message in the Inbox list following or
preceding (respectively) the open message. Those buttons work until the user uses the "Previous
Unified" button or the "Next Unified" button provided by OnePoint Messenger. Then, the Next and
Previous buttons do not work in the currently open message. The user can continue using the
buttons from another Read Message or Read Unified Message form.

Product and Configuration Notes

This section contains notes on the hardware and software not previously covered in the technical
documentation for OnePoint Messenger 2.0. To highlight notes that are new in Revision D of these
Release Notes, their body text is underlined.

Brooktrout Fax Configuration Wizard

The OnePoint Messenger Installation Program installs the Brooktrout Fax Configuration Wizard
on the Telephony Server. In Service Pack 1, the version that is available from the Windows Start
menu is augmented to enable you to select A-Law or Mu-Law encoding for the fax card. When
configuring a fax card for use in the Telephony Server in regions outside Canada and the United
States, select A-Law; otherwise, select Mu-Law.

NOTE: The Brooktrout Fax Configuration Wizard that is embedded in the OnePoint Messenger
installation sequence for the Telephony Server does not provide the A-Law configuration option.
Cards set up in this version of the wizard are set by default to use Mu-Law encoding.

NOTE: Running the Brooktrout Fax Configuration Wizard from the Windows Start menu is
described in Appendix B of the OnePoint Messenger Installation Guide.

Export Button in Statistics Reporting Program

Chapter 8 of the OnePoint Messenger Administrator Guide provides details on Statistics
Reporting Program ("Statistics Tool") that describe the use of the Export button in the report
toolbar. That button is not operable in the version of Crystal Reports shipped with OnePoint
Messenger 2.0.
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Fax Cover Page Logo

See Chapter 4 in Revision A of the OnePoint Messenger Administrator Guide for details on
editing the system fax cover page and a personal custom cover page. In summary, the OnePoint
Messenger\Fax directories on the Telephony Server and on desktop client systems contain
Cover1.cvr, the one cover page template that includes space for a logo. From Windows Explorer,
double-click Cover1.cvr to open it. At the top of Cover1.cvr, right-click the blue box to open a
dialog that provides sizing options for the area containing the logo. You can also select the box,
then use the control handles that appear on the border of the box to move or size it. Your logo will
appear within that area. The default size of the box is 1427 pixels wide by 293 high.

Client systems have a file called Fax_dlg.ini that contains the template option and setting
preferences. Users can assign logos to Logo 1, 2, and 3, and assign signature files to Signature 1,
2, and 3.

NOTE: Ship32.hlp is the help system for the Fax Cover Page Generator. The OnePoint Messenger
Installation Program in Service Pack 1 now installs it on the Telephony Server.

Important Safety Information—Grounding (Earth)

Revision D of the OnePoint Messenger Getting Started Guide adds the requirement for the TS800
that you must connect a hard-wired insulated protective Earth/Ground connection to the Protective
Earth/Ground stud on the rear of the Telephony Server. Failure to provide this connection will
invalidate this product's conformance to minimum legal safety requirements. The Earth/Ground
connection must be provided in accordance with the local wiring codes of the country where
installation takes place (IEE 16th edition Wiring code in the UK, Article 250 of the National
Electrical Code, NFPA 70, or Section 10 of the Canadian Electrical Code CSA C22.1).

Line Card Settings

Appendix A of the OnePoint Messenger Getting Started Guide contains recommended settings and
slot maps that differ from those used to set up the turnkey TS800. Check the Mitel Online website
for an updated version of that guide. From the Mitel Corporation home page, www.mitel.com,
click Login: Mitel Online.

Remote Installation of TS Admin

The OnePoint Messenger Administrator Guide contains a description of how to install TS Admin
(the Unified Messaging Snap-in to Microsoft Management Console) on another workstation in
order to manage the Telephony Server from that other workstation. That description is incorrect,
because the feature is not enabled in OnePoint Messenger 2.0.

To manage the Telephony Server from another workstation, install pcAnywhere on that
workstation. A copy of pcAnywhere from Symantec is included with the turnkey TS800.
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SX-2000 PBX Integration

The OnePoint Messenger/SX-2000 Integration Guide contained on the base software CD-ROM
contains a number of inaccuracies, including:

• Chapter 4 describes setting up an NMS AG-8 card in the Telephony Server. That card is not
supported with the SX-2000 integration.

• Chapter 4 describes setting up an NMS card as the MVIP clock master. In the SX-2000
integration, the SX-2000 provides the clock source through its connection to the AFC card.

• Chapter 4 describes choosing IRQ and I/O base address settings without describing the default
settings

Text-to-Speech (TTS) Dictionary Editor

You can now edit the Text-to-Speech dictionary by installing, on a Desktop Client system, a
shortcut to the editor located on the Telephony Server. For details on installing the shortcut, see
Appendix E in the OnePoint Messenger Administrator Guide.

NOTE: You cannot edit the dictionary directly on the TS800, because the sound card on the
turnkey TS800 Telephony Server is disabled at the factory.

Customer Documentation

The printed OnePoint Messenger Getting Started Guide is included with the TS800 turnkey system and is
also available through your distributor. The complete OnePoint Messenger technical documentation set is
available in Acrobat 3.0 format (PDF) from the \Documents directory on the OnePoint Messenger CD-
ROM.

Online Help
Online help is provided in three client help systems, with help for each of the mailbox clients, and four help
systems, with comprehensive help for all of the OnePoint Messenger server applications. The difference
between two of the server help systems is detailed in the Known Issues section above. Appendix B in the
OnePoint Messenger Administrator Guide provides details on all of the help systems.

OnePoint Messenger 2.0 Documentation Set
The OnePoint Messenger documentation on the software CD-ROM includes the:

• OnePoint Messenger User Guide, Part number: 9164-120-110-NA

• OnePoint Messenger Administrator Guide, Part number: 9164-120-111-NA

• OnePoint Messenger Installation Guide, Part number: 9164-120-112-NA
(for installing OnePoint Messenger on bare systems or reinstalling OnePoint Messenger)
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• OnePoint Messenger Getting Started Guide, Part number: 9164-120-114-NA
(for installing turnkey systems; included in printed form with turnkey systems)

• OnePoint Messenger/Fujitsu Integration Guide, part number: 9169-953-012-NA

• OnePoint Messenger/Nortel Integration Guide, part number: 9169-953-013-NA

• OnePoint Messenger/Lucent Integration Guide, part number: 9169-953-014-NA

• OnePoint Messenger/Centrex Integration Guide, part number: 9169-953-015-NA

• OnePoint Messenger/NEC Integration Guide, part number: 9169-953-012-NA

• OnePoint Messenger/SX-200 Integration Guide, part number: 9164-120-015-NA

• OnePoint Messenger/SX-2000 Integration Guide, part number: 9164-120-016-NA

• OnePoint Messenger Quick Reference Guide, Part number: 9164-953-014-NA, Issue 5
(The TUI menu diagram, included in printed form with turnkey systems -- also appears in the
OnePoint Messenger User Guide). The file is corrupted on the Service Pack 1 CD-ROM.

• Books supplied by Brooktrout Technologies on the OnePoint Messenger CD-ROM:

• Show N Tel System Administrator Guide, File name: sntmgrguide.pdf

• Getting Started with Show N Tel, File name: sntgetstart.pdf

Integration guides in electronic form for the Cisco CallManager and Mitel Ipera IP PBXs integrations are
available. Also available in electronic form is the AllPoint Messenger Guide, for setting up NuPoint
Messenger with OnePoint Messenger systems together, so that NuPoint Messenger can act as the primary
voice mail interface. For details, contact your support representative.

Contacting Technical Publications
The Mitel Technical Publications and Media Development Group maintains this document. We welcome
your questions and suggestions—notes on spelling and grammatical errors, and comments on readability.
Please reference the document number that appears on the back of the cover page. Send your comments to:

techpubs@mitel.com

Acrobat Reader
You can use either Acrobat version 3 or 4 to view the books on the OnePoint Messenger CD-ROM.
Version 3 of the free Acrobat Reader is included on the OnePoint Messenger CD-ROM and installed on the
Telephony Server automatically. You can also download Acrobat Reader 4 from the Adobe website at:

www.adobe.com/products/acrobat/readstep.html


